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 FCC Compliance Statement – Class B  
 
This equipment has been tested and found to comply with the limits for a 
Class B digital device pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate 
radio frequency energy and, if no installed and used in accordance with the 
manufacturer’s instruction manual, may cause interference with radio 
communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by 
turning the equipment off and on, you are encouraged to try to correct the 
interference by one or more of the following measures: • Reorient or relocate 
the receiving antenna. • Increase the separation between the equipment and 
the receiver. • Connect the equipment into an outlet on a circuit different 
from that which the receiver is connected. • Consult the dealer or an 
experienced radio/television technician for help. Changes or modifications not 
expressly approved by the party responsible for compliance could void the 
user’s authority to operate the equipment.  
 

IC Compliance Statement – Class B  
 
This Class B digital apparatus meets the requirements of the Canadian 
Interference-Causing Equipment Regulations of ICES-003. 
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Related Documentation 
The following table lists related Echelon documentation that can be useful when using the U60 
DIN Network Interface products.  The latest versions of these manuals are available from the 
Echelon website at: www.echelon.com/docs. 

Title Part Number Description 

OpenLDV™ Programmer’s Guide 078-0275-01D This document describes Echelon’s 
OpenLDV Network Driver and 
Software Development Kit (SDK) 

Junction Box and Wiring Guideline 
for Twisted Pair LONWORKS® 
Networks 

005-0023-01 This bulletin identifies the different 
types of cabling and junction boxes 
that may be used in twisted pair IzoT 
and LON networks 

IzoT Manual Available online at 
www.echelon.com/docs/izot 

This documentation describes how to 
use the IzoT SDK, a software 
development kit for the IzoT Platform.  
It also describes how to use the IzoT 
Router, a ready-to-run appliance for 
connecting IzoT and LON devices on 
an Ethernet channel with IzoT and 
LON devices on an FT or RS-485 
channel, and for connecting Web pages 
and enterprise applications to IzoT 
and LON devices. 

Support 
If you have technical questions that are not answered by this document, or by the 
related documentation, you can obtain technical support via e-mail. Please contact 
support@echelon.com. 

See www.echelon.com/support for more information on Echelon’s support and 
training services. 

http://www.echelon.com/docs
http://www.echelon.com/docs/izot
mailto:support@echelon.com
http://www.echelon.com/support
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1 
 

Introduction 

This chapter introduces the IzoT U60 DIN Network 
Interface and describes the U60 DIN hardware.  
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Overview 
The U60 DIN Network Interface is a compact network interface for LonTalk/IP and 
LON twisted pair communications.  Two models are available, one for FT (ISO/IEC 
14908-2 TP/FT-10) channels and one for RS-485 (TP/RS-485) channels.  The U60 
provides a USB interface for attaching to a host computer, controller, or router, or for 
attaching to an Echelon IzoT Router.  The U60 DIN Network Interface is packaged in 
a DIN 43880 2TE compliant enclosure. 

You can use multiple U60 DIN Network Interfaces with hosts such as the IzoT 
Router that support multiple channels.  When you attach multiple network interfaces 
to a host, each U60 provides an interface to a single twisted-pair channel.  You can 
use up to four U60 DIN Network Interfaces with the IzoT Router to support routing 
of up to five twisted-pair LON channels, one using the IzoT Router’s internal FT 
network interface, and up to four additional channels with external U60 DIN 
Network Interfaces. 

The U60 has two protocol modes of operation—Layer 2 mode and Layer 5 mode that 
can be selected by the host application.   

In Layer 2 mode, the U60 implements Layers 1 and 2 of the ISO/IEC 14908-1 and 
14908-2 protocol and is compatible with the LonTalk Device Stack EX included with 
the IzoT SDK Standard and Premium Editions.  The LonTalk Device Stack EX 
provides source code for LonTalk /IP and classic LON compatible protocol stacks.   

In Layer 5 mode, the U60 implements Layers 1 through 5 of the ISO/IEC 14908-1 
and 14908-2 protocol and is compatible with Echelon’s previous generation 
Microprocessor Interface Program (MIP) products. 

When used with a Windows computer, the mode is typically selected automatically by 
the application. 

A Service LED indicates the network status of the U60, with Rx and Tx LEDs 
providing an indication of packet reception and transmission. 

The U60 DIN is powered through its USB interface.  

Mechanical Dimensions 
The U60 DIN 43880 2TE enclosure is 35mm (1.38“) wide, 89.5mm (3.52“) high and 
66.5mm (2.62“) deep excluding the network connectors. 
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The U60 FT DIN 
 

Visual Indicators 
Three LEDs are located in the centre of the enclosure.  The yellow Service LED on 
the left (labelled Link or Service), provides a visual indication of the network status 
of the U60.  The RX LED in the middle flashes green when data is received from the 
network.  The TX LED on the right flashes green when data is transmitted onto the 
network.    

The Service status is also provided to the host via the USB interface so that the host 
can provide a network Service indicator if required. 

Connectors  
The U60 FT DIN has a two-way network connector with push clips to retain the 
network cabling.  The network connection is polarity insensitive.   

The U60 RS-485 DIN has a three-way network connector, also with push clips to 
retain the network cabling.  The three positions of the connector are used for the 
following: + (Signal + or B), - (Signal - or A), and SC (Signal Common).  When used in 
unbiased LONWORKS RS-485 networks, the network connection is polarity 
insensitive.  

Both the U60 FT DIN and U60 RS-485 DIN also have Micro B female USB 
connectors for connection to a host processor and come supplied with a suitable USB 
Type A to Micro-B cable. 
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Compatibility 
The U60 DIN is compatible with the IzoT Router, Windows computers with 
OpenLDV 5, with hosts communicating with a Layer 5 MIP interface, and with hosts 
communicating with a Layer 2 MIP interface including hosts implementing the IzoT 
Device Stack EX. 
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2 
 

Getting Started 

This chapter explains how to install and start using 
the IzoT U60 DIN Network Interface.  
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Getting Started with the U60 for an IzoT Router 
You can use the U60 DIN Network Interface to add connectivity to an additional FT 
or RS-485 channel, in addition to the FT channel attached to the LON port of the 
IzoT Router.  You can add up to four additional external U60 DIN Network Interfaces 
(either LON FT or LON RS-485) to the IzoT Router. 

To add one or two external U60 interfaces, plug each U60 into one of the external 
USB ports on the IzoT Router.  To add three or four external U60 interfaces, plug 
each U60 into a port of an external powered USB hub, and plug the USB hub into the 
IzoT Router.  Once you plug in a new U60, the IzoT Router takes a minute to 
reconfigure itself.  During this time Web page access may not be available.  The IzoT 
Router and U60 DIN Network Interface have been tested with the D-Line DUB-H7 
and the Manhattan 10-port powered USB hubs.  You can use any powered USB hub 
that complies with the USB 2.0 standard. 

When you add a new external U60 interface, the IzoT Router automatically creates a 
LAN IP-70 to LON router for the channel attached to the U60 interface.  The routers 
available in an IzoT Router are listed on the IzoT Router System Web page, and you 
can use the Service Pin buttons on this Web page to send Service messages for any of 
the routers.  If you are installing the IzoT Router in a managed network using a 
network management tool such as IzoT CT or the LonMaker tool, you can install the 
routers using your network management tool.  If you have multiple U60 interfaces, 
you can associate you physical U60 interfaces with the listed routers using the MAC 
ID for the U60 interfaces.  The MAC ID for the LON interface of each router is listed 
in the LON column of the router table on the IzoT Router System Web page.  The 
MAC ID for each physical U60 is printed on a MAC ID label that is included with 
each U60 interface.  For easy reference, a 5-digit install code is also printed on the 
label.  The install code is the last 5 digits of the MAC ID, and provides a shorter 
identifier than the 12-digit MAC ID. 

You can add a Layer 5 or Protocol Analyzer Layer 2 remote network interface (RNI) 
for the built-in FT interface and for any of your external U60 interfaces. See the 
Using the RNI and IP-852 Network Interfaces topic in the online IzoT Manual at 
www.echelon.com/docs/izot for more information. 

Getting Started with the U60 for a Windows Computer 
You can use the U60 DIN Network Interface to attach a computer running Microsoft 
Windows to a LON network.  To use a U60 with a Windows computer, install 
OpenLDV 5, attach the U60, and configure the LONWORKS Interfaces application as 
described in the following sections. 

Installing the OpenLDV 5 software 
The OpenLDV 5, or newer, driver is required to use a U60 with a Windows computer.  
OpenLDV 5 is compatible with the IzoT Net Server, OpenLNS Server, and LNS 
Server, and is also compatible with all IzoT Net, OpenLNS, and LNS applications and 
tools including the IzoT Commissioning Tool(CT), OpenLNS CT, and LonMaker 
Integration Tool.  Install the OpenLDV 5 software before connecting the USB DIN 
interface to your computer.  You must have Administrator privileges on your 
computer to perform the installation.  

http://www.echelon.com/docs/izot
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To install the OpenLDV 5 software, follow these steps:  

1. Dowload OpenLDV 5 from here, run the installer and follow the instructions. 

2. The OpenLDV 5 installer includes and automatically installs all required USB 
driver files.  

Connecting the USB Network Interface  
After you have installed the OpenLDV 5 software, plug the U60 Network Interface 
into your computer and connect to an FT or RS-485 channel.  

To do so, follow these steps:  

1. Connect the network cabling to the U60. 

2. Insert the Micro-B USB plug of the supplied USB cable into the USB connector 
on the USB DIN. 

3. Insert the Type A USB plug of the supplied USB cable into an available USB port 
on your computer.  

4. If this is the only LONWORKS interface installed on your computer, it will 
automatically LON1 as the default name, and you can proceed directly to your 
software application and begin using the interface as LON1.  If you have multiple 
LONWORKS network interfaces, you can use the LonWorks Interfaces application 
described in the next section to determine the name of each of your network 
interfaces. 

Using the LONWORKS Interfaces Application 
You can use the LONWORKS Interfaces application to configure, test, reset, or 
remove a LONWORKS USB interface. These procedures are described in the following 
sections. The LONWORKS Interfaces application is in the Windows Control Panel 

Each LONWORKS USB interface has a unique ID, and the LONWORKS Interfaces 
application keeps track of each LONWORKS network interface plugged into a 
computer, even after they have been detached from the computer.  This means that 
you can remove a particular USB interface from your computer and later reattach it, 
and it will continue to use the same LONWORKS network interface name (e.g. LON1 
or LON2) once you reattach it and it is recognized by your computer, regardless of 
how many USB interfaces are plugged into your computer, or in which order.  It also 
means that each USB interface will retain the network interface name assigned to it, 
even after it has been detached from your computer.  
 
The following figure illustrates the LONWORKS Interfaces application windows with 
a U60 FT DIN Network Interface selected. 
 

http://www.echelon.com/resource-library-results?filters=software_downloads,network_interfaces&ps=20
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The list of network interfaces in the left pane of the LONWORKS Interfaces 
application is not automatically updated when you attach a U60 DIN Network 
Interface to your computer.  If you have the LONWORKS Interfaces application open 
when you attach a U60, you can refresh the network interface list by selecting View-
>Refresh from the main menu, or by pressing F5.  You can also close and re-start 
the LONWORKS Interfaces application. 

By default, detached LONWORKS USB interfaces are not displayed by the 
LONWORKS Interfaces application.  To see all LONWORKS USB interfaces, including 
those that are currently detached, select View->Show Detached Interfaces from 
the main menu.  To free the logical name assigned to a network interface, remove the 
definition as described in the Removing a USB Network Interface section below. 

U60 Buffer Configuration  
The following table summarizes the U60 network buffer counts and sizes: 
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Buffer Count Size (bytes) 

Application Input 2 255 

Application Output (non-
priority) 

2 255 

Application Output 
(priority) 

2 255 

Network Input 15 255 

Network Output (non-
priority) 

7 255 

Network Output (priority) 3 255 

 

Testing or Resetting a U60 
To test or reset a U60 DIN Network Interface, follow these steps: 

1. Close any applications and servers using the U60 DIN Network Interface.  You 
cannot test or reset a USB interface if it is in use by another application.  

2. Open the LONWORKS Interfaces application in Windows Control Panel. 

3. Click the network interface name for the network interface to be tested. 

4. You can click a button in the tool bar at the top of the window to test or reset the 
U60 FT DIN.   

a. Click Test to verify communication with the selected network interface.  
A series of statistics will be retrieved and displayed as shown in the 
following figure.  See the online help for a description of the reported 
statistics.  You can open the online help by clicking Help -> Help Topics. 
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b. Click Comm to confirm the ability of the USB interface to communicate 

with other devices on the network.  The LonWorks Interface application 
configures the USB interface to receive Service messages from other 
devices on the network, and waits for messages.  When the LonWorks 
Interfaces application receives a Service message is received, the 
LonWorks Interfaces application will ping that device every second, using 
the selected network interface.  After the pinging begins, the Comm 
button changes to a Quit button.  Click Quit to quit pinging the device.  

c. Click Service to send a Service message to the network. 

d. Click Reset to reset the selected interface.  When you reset the interface, 
the statistic counts retrieved with Test will be set to 0. 

Removing a USB Network Interface 
You can remove and reattach a U60 interface at any time.  When you reattach a U60, 
it will have the same logical name that it had the first time you attached it.  You can 
remove a LONWORKS USB network interface from the LONWORKS Interfaces 
application to reuse the logical name reserved for the network interface.  To remove a 
LONWORKS USB network interface from the LONWORKS Interfaces application, 
follow these steps:  

1. Unplug the USB network interface from your computer. 

2. Open the LONWORKS Interfaces application in Windows Control Panel. 

3. Click View in the main menu, and then click Show Detached Interfaces. 

4. Click the network interface name for the network interface to be removed. 

5. Click Remove in the toolbar. 
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You can reattach a USB network interface that you have removed at any time.  The first 
time you reattach a USB network interface after removing it from the LONWORKS 
Interface application, the interface will be rediscovered and reinstalled as if it is a new 
network interface. 

Getting Started with the U60 for Other Controllers and Hosts 
You can use the U60 DIN Network Interface to add an FT or RS-485 interface to any 
host computer, controller, or router with a USB interface.  To use the U60 interface 
with your host computer, controller, or router, you must implement a U60-compatible 
network driver for your host.  Source code for a Linux driver for the U60 is included 
with the IzoT SDK Premium Edition and is also available for free download from the 
Resources link at www.echelon.com/products/izot-u60-ft-din-network-interface.  See 
Chapter 3, Porting the U60 Driver, for more information on porting. 

 

http://www.echelon.com/products/izot-u60-ft-din-network-interface
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Porting the U60 Driver 

You can use the IzoT U60 DIN Network Interface 
with an IzoT Router or with a Windows computer 
with the OpenLDV 5, or newer, driver.  You can 
also use the U60 interface with other host 
computers, controllers, or routers if you port the 
driver to the new host.  This chapter describes how 
to port the Linux driver for the IzoT U60 DIN 
Network Interface.  
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Porting the Linux U60 Driver 
The Linux U60 driver creates a Linux network device that applications can use to 
send and receive classic LON and LonTalk/IP packets using a U60 network interface.  
The driver provides an open, close, read, write interface and can be used as either a 
network device or a character device.  The Linux U60 driver is included with the IzoT 
SDK images for the Raspberry Pi and BeagleBone Black and is also included in the 
IzoT Router.  Source code for a Linux driver for the U60 is included with the IzoT 
SDK Premium Edition and is also available for free download from the Resources 
link at www.echelon.com/products/izot-u60-ft-din-network-interface.  You can port 
the driver source to other platforms, other versions of Linux, and other operating 
systems. 

The U60 driver requires a unique and valid network device line discipline number.  
By default, the U60 driver uses line discipline number 28 since 28 is a valid but 
unassigned line discipline number for Linux kernel 3.8 as used in the IzoT Router.  
You can use a different line discipline number if 28 is not available or valid for your 
version of the Linux kernel.  The maximum line discipline number is typically 
defined by the NR_LDISCS constant.  For Linux kernel 3.8, NR_LDISCS is defined 
as 30. 

To compile the U60 driver, you first need a compiled kernel source tree, including 
standard Linux support for a USB CDC/ACM class interface.  The IzoT Router uses 
the BeagleBone kernel source tree available at 
https://github.com/RobertCNelson/linux-dev/releases. 

Once you have compiled a kernel tree, run the make modules command in the 
kernel source tree and pass in the directory containing the U50Module source in the 
SUBDIRS environment variable and the directory of the kernel source in the KDIR 
environment variable.  Following are example Linux commands to build the driver: 

 

KERN=/src/3.8.13-bone47/linux-dev-3.8.13-bone47/KERNEL 

U50_DIR=/src/U50Module/ 

make -C $KERN KDIR=$KERN SUBDIRS=$U50_DIR ARCH=arm CROSS_COMPILE=arm-
linux-gnueabihf- modules 

 

The example builds the module as u50.ko to your driver directory.  For the IzoT 
Device Stack EX running on a BeagleBone Black, the driver directory is the 
following:  

 

/lib/modules/3.8.13-bone47/kernel/drivers/lon/ 

 

A udev rule file is required to install the driver.  For example, you can create a udev 
rule file named 90-liftd.rules in the /etc/udev/rules.d directory.  Following is an 
example rule for the U60 (concatenate the two lines): 

 

SUBSYSTEM=="tty", ATTRS{idVendor}=="0920", ATTRS{idProduct}=="5550", 
RUN+="/usr/bin/lonifd -d /dev/%k" 

 

If you modified the line discipline number, you must specify the non-default line 
discipline number in the rule using the -l parameter.   

http://www.echelon.com/products/izot-u60-ft-din-network-interface
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The following example rule includes the -l parameter with a non-standard value of 16 
for the line discipline number: 

 

SUBSYSTEM=="tty", ATTRS{idVendor}=="0920", ATTRS{idProduct}=="5550", 
RUN+="/usr/bin/lonifd -l 16 -d /dev/%k" 

 

You will also need to build the lonifd daemon.  Source code and a make file is also 
included with the U60 driver for the lonifd daemon. 

Once you have built the driver and lonifd daemon, and you have created the udev 
rule file, you can install the driver in Linux using the insmod command.   

This will create a Linux network device.  If you create a single U60 driver, the name 
will be /dev/lon0.  This will not be a character device as was typically used for classic 
LON drivers.  It will instead be a network device that you will access through a 
socket interface.  The benefit of a network device is that it can be easily used with the 
Linux IP stack for supporting LonTalk/IP, for example when communicating with the 
BACnet/IP, ICMP (for ping), or SNMP protocols over the U60.   

If the U60 driver is initialized correctly, you will see the network interface as one of 
the devices listed by the Linux ifconfig command. 

You can bypass the IP stack to use the U60 driver as just a classic LON driver.  The 
following example code opens the U60 socket as a raw character device with a packet 
socket, bypassing the IP stack: 

  

    int sockfd = socket(AF_PACKET, SOCK_RAW, htons(0x8950)); 

  

    struct ifreq ifr = { 0 }; 

    size_t ifnamelen = strlen(ifname); 

    memcpy(ifr.ifr_name, ifname, ifnamelen); 

    if (ioctl(socket, SIOCGIFINDEX, &ifr) < 0) { 

        return errno; 

    } 

  

    struct sockaddr_ll addr = { 0 }; 

    addr.sll_family = AF_PACKET; 

    addr.sll_ifindex = ifr.ifr_ifindex; 

  

    if (bind(socket, (struct sockaddr*) &addr, sizeof(struct 
sockaddr_ll)) < 0) { 

        return errno; 

    } 

 

Using this example code, you can read and write the sockd device using the same 
code used for other classic LON drivers. 

Host Communications 
The U60 communicates with a host over a USB connection using the U60 link-layer 
protocol (LLP).  The driver manages the host end of the U60 LLP, and initializes the 
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U60 when the driver is opened by an application.  The OpenLDV driver for Windows 
includes a U60 driver, starting with OpenLDV 5.   

Protocol Processing Selection 
The U60 has two protocol processing modes of operation, Layer 5 mode and Layer 2 
mode.   

• In Layer 5 mode, Layers 1 to 5 of the ISO/IEC 14908-1 and 14908-2 protocol 
stack are handled by the U60, and Layer 5 messages are exchanged between 
the U60 and the host using the U60 LLP.  Layer 5 mode requires less code on 
the host than Layer 2 mode since Layer 5 mode leverages the ISO/IEC 14908-
1 Layers 3 through 5 protocol stack implemented by the Neuron firmware. 
The U60 Layer 5 driver interface to the host application is compatible with 
the MIP/P20 and MIP/P50 driver interface to the host application.  The driver 
communicates with the U60 using the link-layer protocol (LLP), and the U60 
LLP is different from the MIP/P20 and MIP/P50 LLP.  The U60 LLP is 
described in this section. 

• In Layer 2 mode, Layers 1 and 2 of the ISO/IEC 14908-1 and 14908-2 protocol 
stack are handled by the U60, and Layer 2 messages are exchanged between 
the U60 and the host using the LLP.  The host must implement Layers 3 
through 7 when the U60 is running in Layer 2 mode.  You can use Layer 2 
mode with the Echelon LonTalk Device Stack EX running on the host to 
create high performance controllers that support more address table entries 
and simultaneous transactions than can be supported by the U60 with a 
Layer 5 interface.  The LonTalk Device Stack EX includes a complete 
implementation of ISO/IEC 14908-1 Layers 3 through 5 that runs on a host 
and interfaces with a native LON interface such as the U60 module, or 
interfaces directly with an Ethernet or Wi-Fi interface on the host. 

If you are using the OpenLDV 5 driver for Windows or newer, your application can 
select the protocol processing mode of operation by opening the driver with the 
ldv_open_cap() function and specifying the mode with the nDeviceCaps 
parameter.  Set nDeviceCaps to LDV_DEVCAP_L2 for Layer 2 mode or 
LDV_DEVCAP_L5 for Layer 5 mode. 

If you are using the U60 driver for Linux, you need to specify the protocol processing 
mode in the driver source code, and rebuild the driver for your Linux platform.  The 
protocol processing mode is selected in the call to U50LinkStart() in the 
u50_dev_open() function.  Specify the mode in the last parameter in the call to 
U50LinkStart().  Specify U50_OPEN_LAYER2 for Layer 2 mode or 
U50_OPEN_LAYER5 for Layer 5 mode. 

Link Layer Protocol (LLP) 
The U60 communicates with a host over a USB connection using the U60 link-layer 
protocol (LLP).  The driver manages the host end of the U60 LLP, and initializes the 
U60 when the driver is opened by an application.  

The basic component of the U60 LLP is the code packet, which starts with an 0x7E 
escape code.  If an escape code appears in a normal data stream it is followed by 
another escape code and interpreted as a single data byte value rather than the start 
of the code packet.  The following figure illustrates the code packet layout. 
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 BYTE 0                  BYTE 1                  BYTE 2                   BYTE 3

Escape:            Sequence #,           Param Data        Packet
0x7E                 ACK bit,                                             Checksum
                         Type Code
                          (excludes
                            0x7E)    

  Sequence                 ACK            Type Code
  [D7 – D5]                  [D4]               [D3 – D0]

 
 

The second byte contains a 3-bit sequence number in the sequence bits (D7-D5), a 
single ACK bit (D4), and a 4-bit Type Code bits (D3-D0).  You cannot form the escape 
code by combining a Type Code value with the sequence number (0x0E is not 
allowed).  As a result, you can create 15 different codes.  The Type Code values are 
described in the next section. 

The sequence number is cycled through between values ‘1’ and ‘7’, with ‘0’ being an 
initialization value.  When a code packet is received that has the same sequence 
number as the previous code packet received, the new packet (and any following 
data) is rejected (this transfer will be acknowledged if necessary).  The exception is if 
the sequence number is zero.  The zero sequence number may be used for any 
idempotent code packet or message. 

The third and fourth bytes may contain the escape code value, but they will not be 
interpreted as escape codes.  This may cause minor re-synchronization issues if this 
packet is broken; however, it ensures a constant code packet size. 

The packet checksum is an 8-bit value that, when added to the first three bytes, 
results in an 8-bit zero result. 

The code packet has the following features: 

• Asynchronous method of presenting itself at any time (by using an  
escape sequence) 

• Checksum verification 
• Data transfer initiation 
• Duplication detection using a sequence number—duplicates 

may be sent when an expected response is lost or broken  
and does not occur within a time-out period 

Data outside of the code packet is restricted to either a message or a multi-byte local 
network interface command or response and is always enclosed with a length byte in 
the front and a checksum at the end.  The length byte does not account for the 
checksum at the end—the inclusion of the checksum is implied.  The checksum covers 
the data that preceded it; therefore, it does include the length byte. 

All data outside a code packet must include an escape prefix before any escape data 
values.  For example, if a 0x7E value appears in the sequence it must be followed by 
another 0x7E (the first 0x7E value is the escape prefix).  Checksum bytes and length 
bytes must be preceded with escape prefixes. 
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The following table summarizes the layout of the data message used in Layer 5 mode 
and for the niNETMGMT local network interface command (Layer 2 mode is 
required for the IzoT Device Stack EX).  When sending local network interface 
commands (NI Commands other than niCOMM or niNETMGMT) that have 
additional data, the commands are contained in a data message and they are 
preceded by a CpMsg code packet. 

 
BYTE 0 BYTE 1 BYTE 2..N BYTE N+1 

Length 
(bytes to 
follow 
except 
checksum) 

NI 
Command 

SICB starting w/ message header Message 
Checksum 
of bytes 0-N 

 
The following table summarizes the layout of the data message used in Layer 2 mode. 

 
 

BYTE 0 BYTE 1 BYTE 2..N BYTE N+1 

Length 
(bytes to 
follow 
except 
checksum) 

NI 
Command 

Priority/AltPath/DeltaBacklog byte, 
NPDU, 
CRC (2 Bytes) 

Message 
Checksum 
of bytes 0-N 

 
The U60 supports extended messages that may be up to 1280 bytes in length.  For 
these messages the BYTE 0 length byte will be 0xFF, followed by the MS byte of the 
16-bit length, followed by the LS byte of the 16-bit length, followed by the NI 
command: 

 
BYTE 0 BYTE 1 BYTE 2 BYTE 3 BYTE 4..N BYTE N+1 

0xFF MS byte of 
length 

LS byte of 
length (bytes 
to follow 
except 
checksum) 

NI Command SICB starting 
w/ message 
header 

Message 
Checksum 
of bytes 0-N 

 
For Layer 2 mode: 

 
BYTE 0 BYTE 1 BYTE 2 BYTE 3 BYTE 4..N BYTE N+1 

0xFF MS byte of 
length 

LS byte of 
length (bytes 
to follow 
except 
checksum) 

NI Command Priority/AltPath/
DeltaBacklog 
byte, 
NPDU, 
CRC (2 Bytes) 

Message 
Checksum 
of bytes 0-N 
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Type Code Values 
The following table lists the values for the Type Code byte.  Uplink means that data 
is transferred from the U60 to the host processor.  Downlink means that data is 
transferred from the host processor to the U60. 

 
 
Value 

 
Type 

 
Description 

 
Uplink / 
Downlink 

 
0 

 
CpNull 

 
No data is being sent. Use this value for 
acknowledge-only packets, or for pinging. 

 
U/D 

 
1 

 
CpFail 

 
The previous transfer was broken or in 
error. This is typically due to checksum 
errors or fragmented transfers. The 
correct response to this command is to 
resend the previous transfer.  

 
U/D 

 
2 

 
CpMsg 

 
One message follows. A message is any 
multi-byte network interface transfer and 
requires an application output buffer or 
packet buffer in the downlink case. The 
number of messages is stored in the 
Param Data field. 

 

This value is limited to one in both the 
downlink and uplink case. 

 

The message follows the code packet 
checksum byte, and consists of a length 
byte, the NI command, the message itself, 
and a checksum. 

 
U/D 

 
3 

 
CpMsgReq 

 
Optional. Sent by the host for requesting 
both the attention of the U60 and 
requesting an uplink CpMsgAck. 

 

The Param Data field contains either a 0 
or a 1 informing the U60 that the following 
message is either a non-priority message 
(0) or a priority message (1). The U60 
driver does not use priority messaging; 
therefore, this value is ignored. This 
allows the U60 to respond to the 
CpMsgReq based on actual buffer 
availability. 
  
Alternatively, you can send the entire 
CpMsg plus message to the U60 and a 
CpMsgReject may be sent uplink if there 
are no available buffers. 

 
D 

 
4 

 
CpMsgAck 

 
The U60 is entering the ready-receive 
state. This is the U60’s response to the 
CpMsgReq. 

 
U 
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5 

 
CpMsgReject 

 
An attempt to transfer a message downlink 
is rejected because of a lack of buffer 
space. 
 
This code packet will be a response to a 
downlink CpMsgReq code packet or a 
response to a CpMsg without the 
CpMsgReq being sent. 
 
This code indicates that the offered 
downlink traffic is more than the U60 can 
handle (it has no more APP or NET output 
buffers). 
 
Upon receiving this code, the device driver 
should repeat the message send process 
until it succeeds. 

 
U 

 
6 

 
CpNiCmdShort 

 
Sends a single byte local network interface 
command. The command is stored in the 
Param Data field. 

 
U/D 

 
7 

 
CpResync 

 
This command is sent by the host to start 
a new session with the U60. When 
received it will reset the transmit and 
receive sequence numbers to zero so that 
any subsequent sequence numbers will 
be accepted rather than rejected. 
 
This command is also a good way to 
establish that communications are 
functioning with the U60. 
 
The U60 always responds to this 
command with a CpNull packet, so the 
host can determine that the serial link is 
not simply echoing data. 

 
D 

 
Notes: 
 

• Use symmetrical timeouts on the host processor. There is an inter-byte timeout 
on the client side of 40ms when receiving either a code packet or a message 
body.  There is a timeout of 250ms when waiting for the start of a downlink 
message CpMsg following a CpMsgReq / CpMsgAck sequence. 

 

• All length fields do not count for escape prefixes.  Instead, they reflect the 
length of the real data stream above the link-layer protocol.  All length fields 
do not account for the checksum. 

 

• Broken code packets (code packets with missing or corrupt bytes) are not 
responded to at all, and they rely on time-out mechanisms for re-
transmission. 

 

• Broken message streams are responded to as soon as the error condition 
is observed.  The response is the CpFail code packet. 



  

IzoT U60 DIN Network Interface User’s Guide 
  

25 

Acknowledgement Rules 
The Ack bit is used to send a success response to a previous transfer, specifically 
transfers that send data that is above the LLP (non-LLP data).  These are transfers 
of messages and transfers of local network interface commands. 

To reduce traffic, not all data transfers require acknowledgement.  The following are 
the acknowledgement rules: 
 
• If a transfer requires an acknowledgment and there is no other data that needs 

to be sent, a CpNull packet is sent with the Pass/Ack bit set.  Otherwise, if 
there is outgoing traffic to be sent the Ack bit will be included in the following 
transfer.  This is true for both uplink and downlink data messages. 
 

• Code packets that do not require an acknowledgment via the Ack bit are 
packets that result in an immediate response anyway.  The response implies 
acknowledgment.  The following table lists these types of code packets: 

 
 
Code Packet 

 
Description 

 
CpMsgReq 

 
The U60 will respond with either the CpMsgAck, 
or a criss-cross could occur and an unrelated 
code packet will be sent by the U60. 

 
CpMsgAck 

 
The host does not need to acknowledge this 
message. Instead it provides an implied 
acknowledgement by sending the CpMsg code 
packet followed by a message packet 

 
• Data that is sent and requires acknowledgement will persist in the source until 

the acknowledgment is received.  While the persistent data is waiting for 
acknowledgement, the Acknowledge Wait timeout, which is 300ms for the 
U60 and the driver, causes the persistent data to be re-sent. 

Sequence Number Cycling and Duplicate Detection 
The sequence number is used to reject duplicate non-LLP data.  Duplicate LLP data 
does not affect the LLP; therefore, the sequence number is only cycled for each 
transfer of non-LLP data. For example, two consecutive CpMsgReq packets have no 
effect—the second CpMsgReq packet reinstates the ready-receive state and the 
CpMsgAck is re-sent. 

U60 Command Set 
Uplink local network interface commands that must also convey additional data (for 
example, the niL2MODE response command) will always result in a data message 
that is at least 3 bytes in length.  This is because the host driver expects at least 4 
bytes of data (3 bytes plus checksum) to appear following a code packet. 
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Uplink means that data is transferred from the U60 to the host processor.  Downlink 
mans that data is transferred from the host processor to the U60.  The following table 
lists the U60 commands you can use in your U60 driver. 
 

 
Value Name Description Uplink / 

Downlink 

0x1x niCOMM Passes completion events to the 
host processor. 

 

0x2x niNETMGMT Performs local network 
management or network diagnostic 
commands on the U60. 

 

0x31 niERROR|niCRC The Layer 2 mode U60 will send 
this command uplink whenever it 
senses a CRC error (0x31). 

U 

0x50 niRESET When sent downlink this will 
reset the U60. Following any 
reset the U60 will send this 
command uplink. 

U/D 

0x60 niFLUSH_CANCEL Exits the Flush state. D 

0x70 niONLINE Sets the U60 state to Soft-online. D 

0x80 niOFFLINE Sets the U60 state to Soft-offline. 
No messaging can be handled in 
this state. 

D 

 
 

Value Name Description Uplink / 
Downlink 

0x90 niFLUSH Sets the U60 to the Flush state. D 

0xA0 niFLUSH_IGNORE Sets the U60 to the Flush Ignore 
Comm state. 

D 

0xCx niIO_SET Directly controls the U60’s four I/O 
pins, IO0 – IO3, for general 
purpose I/O control from the U60. 
The L.S. 4 bits are used to 
control these pins.  These pins are 
not accessible on a standard U60 
module or U60 DIN. 

D 
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0xD0 niMODE_L5 Sets the U60 to Layer 5 mode. If 
already in this mode the U60 will 
reply with this command. Otherwise 
the U60 will reset and resume in the 
new mode. This change is 
persistent across resets.  This 
command is issued by the U60 
driver. 

U/D 

0xD1 niMODE_L2 Sets the U60 to Layer 2 mode. If 
already in this mode the U60 will 
reply with this command.  Otherwise 
the U60 will reset and resume in the 
new mode. This change is 
persistent across resets.  This 
command is issued by the U60 
driver. 

U/D 

0xE0 niSSTATUS Provides status information. 
 

When sent downlink, the U60 
responds with the niSSTATUS 
command followed by the 
following 4 bytes of data: 

 

[TXID Value], 

[MIP Version], 

[1 (Layer 2 Mode) or 0 (Layer 5 
Mode)], 

 
[Serial checksum error count] 

U/D 

0xE6 niSERVICE In Layer 5 mode, sends a Service 
Pin message.  Ignored in Layer 2 
mode. 

D 

 

Product Query Network Management Command 
The U60 supports the Product Query network management command from the 
host only. The code for this command is the Network Management Escape code 
[0x7D] followed by the sub-command and command values of [0x01], [0x01]. The 
response includes PRODUCT and MODEL values based on whether the U60 is 
currently in Layer 2 or Layer 5 mode. The App Version is 3.1 (31); the TXID is 4 for a 
TP/FT-10 channel and the TXID is 11 for a TP/RS-485 channel. 
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Appendix A 

Troubleshooting Windows Computer 
Installations 

 
The USB Network Interface software installed by the OpenLDV 5 installer is auto-
configuring.  In the unlikely event that a problem occurs during installation, this 
appendix describes how to diagnose and fix the problem.  If you have a problem that 
is not fixed using the solutions in this appendix, contact Echelon Support at 
support@echelon.com.  

mailto:support@echelon.com
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1. I inserted my U60 network interface into a USB port on my computer, but the Found 
New Hardware Wizard did not open and the computer has not detected the device.  What 
should I do? 
 

• Verify that you are running Microsoft Windows 8, Windows 7, Windows XP, Windows 2000, 
or Windows Server 2003.  

• Verify that you have a USB 1.1, 2.0, or 3.0 host controller on your computer.  
• Verify that other USB devices that you may have work on this computer.  
• Verify that the OpenLDV 5 or newer software has been installed on this computer. You can 

do so by opening the Programs and Features application in the Windows Control Panel, and 
checking that the Echelon OpenLDV 5 item exists (or a newer version).  

• Disconnect all extension cables and external hubs, and connect the U60 interface directly 
into a USB port on the computer using the supplied cable.  

• Try inserting the USB interface into a different USB port.  
• Remove all other USB devices from the computer. 
• Unplug and re-insert the USB interface.  
• Reboot the computer.  
• Verify that the Service LED briefly flashes on and off when you insert the USB interface into 

the USB port. If it doesn’t, then no power is being supplied to the interface.  
• Update your computer with Windows Update. Check that all of the optional software and 

hardware updates are installed.  Windows Update does not automatically select the software 
and hardware updates for installation.  Windows Update is available here  

• Repair the OpenLDV software installation. You can do so by opening the Programs and 
Features application in the Windows Control Panel, selecting Echelon OpenLDV 5 (or a 
newer version) and then clicking Repair.  Follow the instructions to repair the software, and 
then re-insert the USB interface.  

• Check www.echelon.com/downloads for an updated version of the OpenLDV driver.  
 
2. I opened the LONWORKS Interfaces application in the Windows Control Panel and the 
U60 interface is listed on the interfaces pane.  However, it does not respond to the test 
command.  What do I do?  
 

• In the Windows Control Panel, click Device Manager.  Then, check to see if there are any 
devices marked with a yellow exclamation point. Fix all items in Device Manager that are 
marked with a yellow question mark, as there may be driver conflicts preventing the USB 
subsystem or the U60 DIN Network Interface from functioning properly. If the Device 
Manager lists Echelon USB Network Interface under the Ports (COM & LPT) heading, open 
the USB Network Interface item.  If the status indicates that the driver is not working 
properly, first try repairing the OpenLDV software. If that doesn’t work, download the latest 
version of the OpenLDV driver from Echelon’s web site. Both of these options are described 
above.  

• Unplug and re-insert the U60 network interface.  
• If the Device Manager does not list Echelon USB Network Interface under the Ports (COM & 

LPT), check www.echelon.com/downloads for an updated version of the OpenLDV driver. 
 
3. I opened the LONWORKS Interfaces application in the Windows Control Panel and there 
is not an entry for the U60 in the interfaces pane, but the Echelon USB Network Interface 
is listed in the Ports (COM & LPT) section of the Device Manager.  What do I do?  
 

• Open the Device Manager, then expand the Ports (COM & LPT) item and double-click 
Echelon USB Network Interface to open the Properties dialog. Re-check the LONWORKS 
Interface application in Control Panel.  The missing entry should have been re-created.  

• In the LONWORKS Interfaces Control Panel application, try selecting View->Refresh from 
the main menu, or by pressing F5. 

http://windowsupdate.microsoft.com/
http://www.echelon.com/downloads
http://www.echelon.com/downloads
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• If the U60 network interface does not function properly after performing the actions 
described above, perform the suggested steps in the other items in this Troubleshooting 
section before contacting Echelon Support. 
 

 4. Windows displays a message saying it cannot install the driver 
 
 The USB interface was plugged into the computer before the OpenLDV software was installed.  
 

• To prevent installation errors, install the OpenLDV 5 software before connecting the U60 
network interface to your computer.  If you have not previously installed the software before 
attaching the U60, Windows will inform you that it could not install the device and the U60 
Network Interface will show up under Other Devices in the Device Manager Control Panel 
application.  Remove the U60, install the latest version of the OpenLDV software that is 
available at www.echelon.com/downloads, then re-connect the U60 and check the 
LONWORKS Interfaces application to ensure the U60 is listed in the interfaces pane. 
 

• If the USB interface does not function properly after performing the action described above, 
perform the suggested steps in the other items in this Troubleshooting section before 
contacting Echelon Support. 

http://www.echelon.com/downloads
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